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 1. Before Starting

 

i 
Note: updated version of FlashRunner System 
Software is available on SMH Technologies website 
(www.smh-tech.com). Please check it before 
continuing reading this documentation.

1.1 Important Notice to Users

While every effort has been made to ensure the accuracy of all 
information in this document, SMH Technologies assumes no 
liability to any party for any loss or damage caused by errors or 
omissions or by statements of any kind in this document, its 
updates, supplements, or special editions, whether such errors 
are omissions or statements resulting from negligence, 
accidents, or any other cause.

1.2 Getting Technical Support

SMH Technologies is continuously working to improve 
FlashRunner firmware and to release programming algorithms 
for new devices. SMH Technologies offers a fast and 
knowledgeable technical support to all of its customers and is 
always available to solve specific problems or meet specific 
needs.

9
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To get in touch with SMH Technologies, please refer to the 
contact information below.

Phone: +39 0434 421111
Fax: +39 0434 639021
Technical Support: support@smh-tech.com

10
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2 System Setup/Upgrade

2.1 Software Setup

The FlashRunner system software setup installs all required 
components to your hard drive. These components include:

 FlashRunner 2.0 Workbench software;
 Command-line utilities and Interface Library;
 Documentation in PDF format.

To install the FlashRunner system software:

 Check latest “System Software” package for FlashRunner 
2.0 on SMH Technologies website;

 Follow the on-screen instructions in order to install the 
System Software.

To launch FlashRunner 2.0 Workbench under Microsoft 
Windows®, select Start →  Programs → SMH Technologies 
→ FlashRunner 2.0 → FlashRunner 2.0 Workbench. 
Then click on File → Connect menu item in order to connect to 
FlashRunner 2.0. If icon will change to “plugged state”, your 
product has been connected succesfully.

11
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2.2 What do you need to start

FlashRunner 2.0 supports several devices. In order to program 
a specific device you will need the following:

 A driver file (.so);
 A license file (.lic);
 An FRB file (.frb);
 A project file (.prj);

Driver files are dynamic libraries which contain routines needed 
to program a set of specific devices. SMH Technologies 
releases daily updates in order to support new devices, so 
when you request a new device you'll often receive also an 
updated version of the driver.

License files are text files which contains a CRC key which bind 
together your specific FlashRunner 2.0 (by using its unique 
serial number) with your taget device. There are different 
licenses type: license for a single target device, license for a 
single family, license for a silicon manufacturer. Please ask 
SMH Technologies Sales Team for more information.

FRB file is the FlashRunner proprietary file format used to store 
customer firmware. There is a specific tool available from 
FlashRunner 2.0 Workbench, called FRB Manager, described 
on ch 3.14. 

Project files are text files contaning all the necessary 
information for setting your programming session. They 
contains some static information regarding device, all user 
configurable parameters and all commands which will be 
executed on target device. FlashRunner 2.0 Workbench has a 
tool, Project Wizard, described on chapter 3.8 which allow 

12
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users to create a project from scratch only using graphical 
items. Once created, a project could be modified by simply 
editing it with a text editor.
All files are stored in user data path which can be found or 
changed on Tools → Settings menu items, “Paths” tab.

On SMH Technologies website (www.smh-tech.com) you can 
check the full supported device list. 
In order to program a specific device a specific license file 
for the couple “device and programmer” (identificated by 
its serial number) must be purchased.
You can purchase a license through our direct channel by 
writing to our Sales Office: sales@smh-tech.com or, if you 
bought FlashRunner from an SMH distributor, please contact 
him.
Once bought a license you'll receive a package with a license 
file and a driver file, which must be copied to your FlashRunner 
2.0 product.

2.3 Connection setup

FlashRunner 2.0 Workbench is able to control programmer in 
Host mode (via USB or Ethernet connection), or in Standalone 
mode (via Control Connector) which is able to select and run a 
specific project stored in its internal storage memory. For first 
use and, in order to connect it to FlashRunner 2.0 Workbench, 
you'll have to use FlashRunner 2.0 in Host mode.  

13
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ETHERNET LAN CONNECTION SETTINGS:

By default FlashRunner 2.0 IP address is 192.168.1.100, with 
SUBNET MASK 255.255.255.0 and gateway 192.168.1.1. After 
first time connection you'll be able to change this settings using 
SETIP command (see ch 4.4.28).

Please use ethernet cable included in FlashRunner 2.0 box and 
connect it to your switch or directly to your host pc. Once 
connected together, red cross in network connections icon 
related to your network card should disappear.

If host pc and FlashRunner 2.0 are connected through a router, 
please be sure that they are running in the same subnet: host 
pc IP address must be included between 192.168.1.1 and 
192.168.1.254 address range.

If your pc and FlashRunner 2.0 are directly connected, you'll 
need to set a static IP on network card used for connecting host 
pc with FlashRunner 2.0. Please open network card settings 
window and use the following: 

 IP ADDRESS: 192.168.1.X (where X is whatever number 
from 1 up to 254 except 100, which is FlashRunner IP) 

14
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 SUBNET MASK: 255.255.255.0 

 GATEWAY: 192.168.1.100

FlashRunner 2.0 Workbench is configured by default to connect 
to 192.168.1.100 FlashRunner 2.0 IP address. If you'll need to 
change FlashRunner 2.0 IP address you can easily update also 

15

Figure 2: Settings example
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FlashRunner 2.0 Workbench settings using Tool → Settings 
menu item.

USB CONNECTION SETTINGS – WINDOWS® PROCEDURE:

Once connected USB cable, please check on Device Manager 
→ Ports (COM & LPT) if you can find USB Serial Port (COMX). 
Where X is an integer number If not, please click Action → 
Scan for hardware changes.

Once found this item, please sign which COM port has been 
assigned to FlashRunner and use it to setup FlashRunner 2.0 
Workbench software: please click on Tools → Settings, click on 
“Serial” connection type and put COMX value inside  Port 
textbox.

16

Figure 3: Device Manager
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USB CONNECTION SETTINGS – LINUX PROCEDURE:

Please check with dmesg command which device node has 
been assigned to FlashRunner 2.0. Usually Linux assigns 
ttyUSBX (where X is an integer number) device node. Please 
check under /dev folder if your user has write/read privileges on 
/dev/ttyUSBX device node. If not, please add it through chmod. 
Please open FlashRunner 2.0 WorkBench Tools → Settings, 
select Serial Connection Type and fill Port textbox with 
/dev/ttyUSBX.

17

Figure 4: FlashRunner 2.0 WorkBench settings window
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2.4 Firmware Update

In order to update FlashRunner 2.0 simply follow the procedure 
below:

 Check on SMH website (www.smh-tech.com) or ask to 
Technical Support (support@smh-tech.com) for an update 
package

 You'll get an update.tgz file
 Use FlashRunner 2.0 Workbench Advanced File Manager 

to upload this file as is (don't uncompress it) in “Driver” 
folder. 

 Reboot FlashRunner 2.0
 If update.tgz disappeared from “Driver” folder you 

succesfully updated your product. Use SGETVER 
command to check new OS version.

18
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3 FlashRunner 2.0 Workbench

3.1 Overview

FlashRunner 2.0 Workbench is a simple application for pc 
which is able to communicate with FlashRunner 2.0 and 
perform the following operations:

 Create new projects
 Run projects and monitor programmer status
 Create FRB binary files
 Copy projects, FRB, drivers and licenses from/to 

programmer;
 Update OS
 Retrieve log

FlashRunner 2.0 Workbench is compatible with all Microsoft 
Windows® operating systems and with Linux operating system.

19
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3.2 Main window

Once you run FlashRunner 2.0 Workbanch you'll see a window 
like the one in figure above. It's designed with a top toolbar, a 
left toolbar and a central area composed by three tabs:

 Project Setup: review all settings of the current project. 
This window will be described in chapter 3.5

20

Figure 5: Main FlashRunner 2.0 window
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 Production Control: monitor the on going programming 
session. This window will be described in chapter 3.6

 Security: setup the security features for the current 
programming session. This window will be described in 
chapter 3.7

Project Setup tab and Production Control tab will be “active” 
only after creating a new project (see ch 3.8) or after loading it,

3.3 Top toolbar

From left to right left toolbar provide the following features:

 Connect button: connect/disconnect from FlashRunner 2.0 
and review connection status.

 Send configuration button: send project and frb
 Send button: click in order to send FRB, library, project, 

license
 Get button: click in order to get FRB, library, project, 

license

3.4 Left toolbar

Left toolbar shows the most important features of FlashRunner 
2.0 Workbench at a sight.

  Create project wizard. See ch 3.8

  Edit actual / existing project 

  Load project

21
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  Settings

  FRB encryption. See ch 3.9

  Show device list

 Advanced File Manager. See ch 3.10

 Terminal. See 3.11

 Log. See 3.12

 Download Production Report 

22
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3.5 Project setup

Once created a project or after loading it you'll see on Project 
setup a review of all the peoject settings. Moreover, you will get 
also information about connections and wirings. They are 
available on the top of Project Setup report or through the 
PinMap View described at ch 3.13

23

Figure 7: Project Setup tab
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3.6 Production Control

Once you load a project “Production Control” will load a widget 
for each channel defined inside the project. Each widget 
contains the following labels:
 Device: shows target device name defined for that channel
 Binary File: shows FRB file defined for that channel
 Run: button which starts project only on that single channel
 Prog. Time: shows total execution time for that channel
 n° of PASS:  shows number of succesfull project 

executions for that channel
 n° of FAIL: shows number of failed project executions for 

that channel

24
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 Status: label which reports actual channel status. There are 
four possible states: 

1. Pass: last project execution completed succesfully 
and channel is idle

2. Fail: last project execution failed and channel is idle
3. Idle: channel is waiting for project execution
4. Busy: channel is running a project.

On the left side of Production Control there are the following 
labels:
 Project Name:  shows project name currently loaded
 Operator Name:  shows operator name

25

Figure 8: Production Control tab
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 N. Prog Cycles:  shows total number of project executions
 Total N° of PASS:  shows total number of succesfull project 

executions
 Total N° FAIL:  shows total number of failed executions
 PASS Percentage: shows actual pass percentage over the 

total number of project executions
 Total  prog. Time:  shows total time spent on current 

programming session (i.e. since the first project execution)
 Prog. Time Average: shows average of project execution 

time for each channel
 Cycle Program Time: shows project execution time
 Stress Test: if checkbox is ticked, Run botton will loop 

project execution. Once unticked, loop will be disabled and 
last project execution will leave channel in idle state. You 
can also limit total number of project executions by using 
“Limited to” checkbox and defining a total repetitions 
number.

 Send: this button will upload project and FRB to 
FlashRunner 2.0. 

 Run: this button will start project execution over all the 
defined channels.

 Clear: this button will clear text on all labels.

3.7 Security

<coming soon>

3.8 Wizard

FlashRunner 2.0 collect all the user settings related to the 
programming sessions in text files called “projects”. Inside each 
project you'll find a set of commands (all rows beginning with “#” 
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character are commands, see ch 5) which, of course, could be 
sent one by one through our interface library, through serial port 
or through “Terminal” tool of FlashRunner 2.0 Workbench. 
Having a single file including all this settings however bring 
several benefits to users, which they could save on a single file 
all the settings needed to program a specific device and running 
a complete programming cycle with only one click.
Wizard tool is one of the most innovative features of 
FlashRunner 2.0 Workbench and let users create a complete 
working project using only graphic items. A set of wizard pages 
will guide users toward all the specific device settings. Once 
completed, a project file will be created inside the FlashRunner 
2.0 data folder (which can be found or changed on Tools → 
Settings menu items, “Paths” tab) and must be uploaded to 
FlashRunner 2.0 before executing it.

27
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You can create a new project using File → New Project. First 
wizard page will let you set project file name.

Next page, Channel selection, will let you define channels set 
for which the following settings will apply.

28

Figure 9: Wizard Introduction page
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If FlashRunner 2.0 Workbench is connected to the product you 
will have, depending on how many channels are enabled on 
FlashRunner 2.0, you'll have a set of checkboxes enabled. 
If you leave unticked some checkboxes, at the end of the 
wizard you'll have the chance to start over and setup all the 
remaining undefined channels.

29

Figure 10: Wizard Channel selection window
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This page will let you select which target device you want to 
program for channels defined in the last page. Remember that 
each device needs its library, wrote in “Driver” column, make 
sure to have this library, in case ask SMH Technolgies technical 
support at support@smh-tech.com for an updated version.

30

Figure 11: Wizard Device selection page
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In FRB management page you'll find a powerful tool to create 
an FRB file (i.e. FlashRunner Binary file) which will contain all 
the source files (more than one are allowed) needed to program 
target device with your firmware. You can reach this tool via 
Project Wizard or by selecting Tools → FRB Manager. There's 
an important difference between this two paths: converting an 
FRB through the Project Wizard will let you create an FRB 

31

Figure 12: FRB management page
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using selected target device memory addresses as reference, 
using it through Tools → FRB Manager it doesn't. Moreover, 
once created FRB file, Project Wizard will define an address 
map which will filter programming commands available.
FRB management is described in detail on ch 3.14

3.9 FRB encryption

An existing FRB could be encrypted through FlashRunner 2.0 
Workbench software. You simply have to click on Encrypt FRB 
button of left toolbar (see ch 3.4) and choose FRB file you want 
to encrypt. FlashRunner 2.0 will provide a new file in the same 
folder, with the same filename and .frs extension, which is the 
encrypted version of the original FRB. 
If you have a project which uses the original FRB file and you 
want to substitute it with its encrypted version, please modify 
project file with a text editor at #TPSETSRC command line and 
update it to FlashRunner 2.0. 
Encryption method implemented is AES256.

32
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3.10Advanced file manager

Advanced File Manager is a easy tool for updating or retrieving 
files to/from connected FlashRunner 2.0. On the top side you'll 
find your local resources, on bottom side you'll find 
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Note: once encrypted, FRB file can't be decrypted 
anymore.

Figure 13: Advanced File Manager



2

FlashRunner 2.0 Workbench

FlashRunner 2.0 resources, in which only five folders are 
available and are shown in the middle toolbar. 
As the name suggest, project files (.prj) must be copied in 
“Project” folder, drivers (.so) must be copied in “Drivers” folder, 
licenses (.lic) must be copied in “License” folder, FRB files must 
be copied in “FRB” folder, log file is available in “Log” folder.
Once clicked a file from your local resources, please click a 
destination folder and then click “Send” button. Viceversa, 
select a file from FlashRunner 2.0 folder and click “Get” button.

3.11Terminal

Host pc interact with FlashRunner 2.0 via synchronous serial 
communication. Host send commands and receive answers, for 
detailed information regarding communication syntax and 
available commands please see ch 4.

34
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On top left side of the window a label will show you which 
channel is actually selected. In order to send a command write 
it inside editable combo box1 at its right, or check command 
history with the combo box drop down menu, finally click “Send” 
button. If you want to send a command to all channel simply 
click “Send all” button. If you want to change channel please 
select it with the button toolbar at bottom right side.

1

Please note that command combo box will automatically 
add “#” character, if not entered.

35

Figure 14: Terminal tool
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3.12Log

Real Time Log feature show complete tracking of FlashRunner 
2.0. activity.
“Communication” tab will show full commmunication based on 
received commands, while “Channel communication” fill filter 
out communication by single channel. You can select a channel 
by using the bottom right toolbar. “Log” tab will show all 
operation executed by FlashRunner 2.0, including commands 
included in project files. Each row is composed with the 
following syntax:

<channel>|<log level>|<timestamp>|---<command sent>
<channel>|<log level>|<timestamp>|<command answer>

Example:
08|2|001208-04:47:54|---#TPCMD CONNECT 
08|1|001208-04:47:54|PROT_CLK: Req=12500000 
Actual=12500000
08|2|001208-04:47:54|>|

Log Level is a number from 1 up to 6 and define logging 
verbosity level. Level 1 is the most concise, level 6 is the more 
verbose. You can change log verbosity with SETLOGLEVEL 
command (check ch 3.12).

Timestamp shows in which moment a command has been 
executed. Syntax used for timestamp is:
<year><month><day>-<hour>:<month>:<seconds>

Each field takes 2 characters. 
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For each command sent there could be one or more answer 
lines.

37

Figure 15: Real Time Log window, Communication tab
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3.13PinMap View

PinMap tool is an handy feature which helps users to do cable 
wirings from target device to FlashRunner 2.0 ISP connector. 
Once created/loaded a project, items connections combobox 
will be filled with channels defined in the loaded project. 
Clicking on one of the channels available in the drop down 
menu will load a table on right side of the window, which lists all 
signals involved for device connection on that specific channel.  
Once clicked, related pins will become coloured and clicking on 
one of them will highlight the related signal in the signals table. 
Please note that FlashRunner 2.0 has one or two ISP 
connectors based on product version: FlashRunner 2.0 
versions with 8 or less active channels will have only one ISP 
connector, FlashRunner 2.0 with more than 8 active channels 
will have two ISP connector. Please pay attention to the 
connector indication on top of signals table: first 8 channels are 

38
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related to the main connector, channel 9 up to 16 are related to 
sandwitch connector. 

3.14FRB manager

In FRB management page you'll have a powerful tool to create 
an FRB file (i.e. FlashRunner Binary) which contains all the 
source files (more than one are allowed) needed to program 
target device. You can find this tool via Project Wizard or by 
selecting Tools → FRB Manager. 

Pay attention: converting an FRB through the Project Wizard 
will let you create an FRB using selected target device memory 
addresses as reference, using it through Tools → FRB 
Manager instead, it doesn't. 
Moreover, once created FRB file, Project Wizard will define an 
address map which will filter programming commands available.

39

Figure 17: FRB Manager conversion mode selection
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FRB Manager converts main source file formats:
 RAW Binary
 Intel Hex
 Motorola SREC

First FRB Manager page let user choose which mode do he 
wants to use in order to achieve conversion:
 Standard FRB setup
 Advanced FRB setup

3.14.1 Standard FRB setup 

It's the fast way of achieving source file to FRB conversion: 
simply select a source file in the file format described above. 
FRB will be converted and saved in the standard user data 
folder with same filename as the selected source file.
You can also select an existent FRB: in this case, in place of 
conversion, tool will read FRB and load it's content. 

3.14.2 Advanced FRB setup

Advanced FRB setup will enable full features to users in order 
to let them compose their own FRB file. Users can import 
multiple source files, edit single blocks start address and size, 
remove blocks and add “fill” or “variable data” blocks.

40
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In order to create a new FRB please click “New FRB” button at 
top left of the page and then click to “Add” button at top right.
Once clicked, you'll see a window with three options:
 Import from source file
 Fill data
 Variable data

Import from source file
By choosing this option you can import a source file defined by 
the format selected on related combo box. In case of Intel Hex 
or Motorola SREC you'll have to choose also encoding type: if 
data has been defined by word or by bytes. If you are not sure 
on what to select use “Byte encoding” option.
Data parsing will be achieved by reading and merging together 
all the source file rows which define adjacent data areas, each 
disjointed block will define a new data area and will be placed in 
a new row.  

41

Figure 18: Add data to FRB
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Fill data
By choosing this option you can define a “filling” block, this 
means that from defined “start address” and for “size” lenght, 
target device memory will be programmed with the defined “fill 
value”. This block will not impact total FRB size and could also 
overlap existing data.

Variable data
Choosing this option you can define a “variable data” block, 
which will not define any value to be written on target device 
inside FRB, but it will used for dynamic content definition during 
target device programming (please check ch 6 for detailed 
information).

Once you add some data inside the new FRB file, you'll have 
some data rows inside input data table. If a data block 
overlapping occurs, two blocks involved are highlighted in red. 
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Next/Finish button will be disabled unless you solve the conflict 
or you explicitly decide to leave this conflict unresolved.

In order to modify a single data block you need to select it on 
input data table and then click on “Edit” button on top left of the 
window.
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i 
Data block overlapping conflicts will be solved 
following this rule: last data block (in row order) will 
overwrite overlapping data of the first data block.



2

FlashRunner 2.0 Workbench

Once clicked on “Edit” button, a new window will appear and 
will let you edit block offset, target start address and size. If you 
use FRB Manager through the Project Wizard, you'll also have 
a device memory map at the bottom side of the window which 
will help you to place this block within the target device memory 
regions. If your settings will not fit any device memory regions a 
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warning will appear in red at the bottom side of the window. As 
a result, data blocks which doesn't fit any device memory region 
will not be programmed at all on target device flash memory. 

Source address Setup
This text field defines the offset from which FlashRunner 2.0 will 
start reading the block. Standard offset value is 0, meaning that 
by default it will start reading block from its first address

Target address Setup
This text field defines from which target device address will 
FlashRunner 2.0 start programming this block. Default value is 
the first address parsed from the source file.

Size
This text field defines how many block bytes will be 
programmed on target device. Default value is the full block 
lenght.
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4 FlashRunner 2.0 Commands

4.1 Overview

FlashRunner is set up and controlled via ASCII-based 
commands. FlashRunner can receive and execute commands 
in two ways:

 Over a USB or Ethernet connection (Host mode);
 Via signals received by its “Control connector” which are 

able to select and run a specific project stored in its internal 
storage memory (Standalone mode).

In the first case, FlashRunner is controlled by a host system; in 
the latter case, FlashRunner works in standalone mode and is 
fully autonomous inside an integrated production system.

4.1.1 Host Mode

In Host mode, commands are sent from host system to 
FlashRunner:

 By using a TCP/IP command-line utility (like Termite© on 
Microsoft Windows©);

 By using any programming language that is able to send 
and receive data to/from a host system COM port or 
Ethernet port (i.e. Microsoft Visual C++/Visual Basic, 
National Instrument LabView/LabWindows, etc.) An 
Interface Library is available upon which you can build your 
own application (see “P” on page 99).

Alternatively, you can use the FlashRunner 2.0 Workbench 
software to send commands to the instruments.
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4.1.2 Standalone Mode

In Standalone mode, FlashRunner 2.0 does not need a 
connection to a host system. A group of control lines (SEL[4..0] 
in the “CONTROL” Connector) determines which of the 32 
available projects stored in FlashRunner 2.0 memory must be 
executed.
A project is simply a text file containing a sequence of 
FlashRunner 2.0 interface commands, plus some project-
specific directives. Projects are explained in detail in the ch 5.

4.2 Command Syntax

4.2.1 Sending a Command

Each command, except project-specific directives shown in 
table 5.2 must start with # character (FlashRunner 2.0 Terminal 
tool automatically adds this character). Each command has a 
different coverage, described in chapter 4.3, but at first glance a 
command could be sent to:

• Master engine
• A single site engine
• All engines
• All site engines 
• A subset of site engines
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i 
Note (for TCP/IP command-line utilities): 
FlashRunner 2.0 factory IP address is 192.168.1.100 
and data is exchanged on port 1234.
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A command sent to a single engine begins with # character 
followed by <channel number>, followed by * character, followed 
by the command name, followed by a space, followed by zero, 
one or more parameters (separated by a space), and a final 
Carriage Return character. All parts of a command are case 
sensitive. Channels number starts from 1 up to 16 plus the 
master engine which is 55. 
A command sent to all engines in parallel begins with # 
character, followed by the command name, followed by a 
space, followed by zero, one or more parameters (separated by 
a space), and a final Carriage Return character.
A command sent to a subset of site engines begins with # 
character followed by <engine mask>, followed by ! character, 
followed by the command name, followed by a space, followed 
by zero, one or more parameters (separated by a space), and a 
final Carriage Return character, where <engine mask> is a 
decimal number which identifies bitwise channels on which 
command must be executed.
FlashRunner 2.0 Workbench software is able to send 
commands via Terminal tool, which is automatically adding 
#<channel number>* prefix. Before sending a command, please 
click on the bottom right side of the window the channel for 
which you want to send the command. 
Project files contain ENGINEMASK pseudo-command which 
already defines which engines will be involved for the following 
commands. For this reason, commands inside a project file 
don't needs channel prefix. Thus, inside a project a command 
will be # character,  followed by the command name, followed 
by a space, followed by zero, one or more parameters 
(separated by a space), and a final Carriage Return character.

48



2

Command Reference

4.2.2 Receiving the Answer

After receiving a command from the host system and executing 
it, FlashRunner 2.0 responds with an answer string. The answer 
string is composed by zero or more response characters, 
followed by one result character, followed by a final Carriage 
Return. The result character is:

• > if the command has been executed successfully or
• ! if the command generated an error.

Below are two examples of answer (with and without error):

 

0x00 0x00 0x00 0xFF>[LF] 

Response 
Characters 

Result 
Character 

(OK) 

0x0901![LF] 

Result 
Character 
(ERROR) 

Response 
Characters 

(Error Code) 

Line 
Feed 

Line 
Feed 

Figure 21: Typical answer
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i 
Note: when sending commands via a terminal utility, 
the Line feed character is automatically sent when 
you press the Enter key on your keyboard.
Likewise, inside a script, the Line feed character is 
automatically inserted at the end of a script line when  
you press the Enter key on your keyboard to start a 
new script line.
The Carriage Return character, however, must be 
programmatically added to the command string when  
sending the command from a programming 
language.
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When a FlashRunner 2.0 command executes successfully, 
FlashRunner 2.0 typically answers with just the engine number 
which gives the answer, followed by | character, followed by > 
character (unless the command requires data to be returned 
back—see figure above).
When a FlashRunner 2.0 command generates an error, 
FlashRunner 2.0 answers with a four-digit hexadecimal error 
code followed by the ! character (see figure above).

4.2.3 Numeric Parameters

Every numeric command parameter can be expressed either in 
decimal or hexadecimal format. Hexadecimal numbers must be 
preceded by the 0x symbol. The figure below shows three 
example of usage of the DMSET command to write two bytes on 
FlashRunner 2.0 dynamic memory. This two examples below 
are equivalent:

#DYNMEMSET 0x8E0400 0x2 0x00 0xFF
#DYNMEMSET 9307136 2 0 15

Numeric parameters returned by FlashRunner 2.0 as command 
answer (CRC, memory data, error codes, etc.) are expressed in 
hexadecimal or decimal format, depending on the case.

4.3 Command Summary

The following table summarizes all of the FlashRunner 2.0 
commands. Each command is fully described in the “Command 
Reference” section. The “Type” column describes if a command 
will work on channel engines (“S”) or for the master engine only 
(“M”). 
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Command Syntax Description Scriptable Type

File System Commands

CLRERR Clears the errors stack NO M + S

CLRLOG Clears the log file NO M

FSEXIST Check if a file do exist inside 
FlashRunner memory

NO M

FSGETCONTROL Read control interface value NO M

FSGETFILE Gets file from FlashRunner NO M

FSLS Lists files NO M

FSPUTFILE Puts file to FlashRunner NO M

FSRM Remove file NO M

FSSETCONTROL Set control interface value NO M

GETDATE Gets the actual FlashRunner date/time NO M

GETFILE Gets file from FlashRunner NO M

GETVPROG Read a power line value NO S

ISPANELMODE Returns FlashRunner working mode NO M

LISTLIC Returns licenses list NO M

LOGIN Login an user account NO M

LOGOUT Logout an user account NO M

PUTFILE Puts file to FlashRunner NO M

SETADMINPWD Set administrator password NO M

SETDATE Gets the actual FlashRunner date/time NO M

SETIP Sets up FlashRunner IP address NO M

SETLOGLEVEL Sets the log verbosity level NO M + S

SETMUX Drives demuliplexer NO M

SETPANELMODE Change FlashRunner working mode NO M

TESTVPROG Sets up a defined value on VPROG 
lines

NO S

Status Commands

GETENGSTATUS Gets actual engine status NO M

SGETENG Returns the activated engines number NO S

SGETERR Returns detailed error information NO M + S

SGETSN Returns the FlashRunner  serial 
number

NO M

SGETVER Gets version NO M

SGETVERALGO Returns driver version NO M

SGETVERALGOLIST Gets entire driver list with version NO M

SPING Pings instrument NO M

RSTENGSTATUS Resets engine status NO M
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Command Syntax Description Scriptable Type

Dynamic Memory Commands

DYNMEMCLEAR Clears dynamic memory YES S

DYNMEMSET <start addr> <len> 
<data> <data> ... Defines a dynamic memory data patch YES S

DYNMEMSET2 <start addr> <len> 
<data stream> Defines a dynamic memory data patch YES S

Target Configuration Commands

TCSETDEV <dev setting name> <dev 
setting value> Sets target device information YES S

TCSETPAR <par name> <par value> Sets target device parameter YES S

LOADDRIVER <driver> <silicon> 
<family> <device> Sets target device YES S

RLYCLOSE Closes the specified relay YES S

RLYOPEN Opens the specified relay YES S

Script Execution Commands

RUN <script file> Executes the specified script YES S

Target Programming Commands

TPCMD <command> [par1] [par2] ... 
[parn] Executes programming command YES S

TPEND Ends programming sequence YES S

TPSETDUMP <filename> Sets data destination YES S

TPSETSRC <filename> Sets data source YES S

TPSTART Starts programming sequence YES S

Script Execution Commands

RUN <script file> Executes the specified script NO S

Pseudo commands

ENGINE Select an engine YES S

ENGINEMASK Select an engine subset YES S

CRC CRC calculation YES S
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4.4 Command Reference

Each FlashRunner command is listed alphabetically and 
explained in the following pages.

4.4.1 Command Documentation Conventions

The following conventions are used in the documentation of 
FlashRunner commands:
 Uppercase text indicates a command name or a command 

option that must be entered as shown.
E.g. SGETVER

 Lowercase text between <> indicates a command 
parameter name.
E.g. TPSETDUMP <filename>

 Lowercase text between [] indicates an optional command 
parameter.
E.g. TPCMD <command> [par1] [par2] ... [parn]

 A vertical bar indicates a choice between two or more 
command options.
E.g. TPCMD MASSERASE F|E|C

Please note that, except from examples, all the 
commands are provided without the #<ch>* prefix.
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4.4.2 CLRERR

Command syntax:
CLRERR

Scriptable: No

Available on: Master and site engines

Parameters:
None.

Answer data:
Success: none.
Error: none.

Description:

Clears the error stack.

Example:
#55*CLRERR
55|>
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4.4.3 CLRLOG

Command syntax:
CLRLOG

Scriptable: No

Available on: Master engine only

Parameters:
None.

Answer data:
Success: none.
Error: the error code.

Description:

Clears the log file.

Example:
#55*CLRLOG
55|>
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4.4.4 DYNMEMCLEAR

Command syntax:
DYNMEMCLEAR

Scriptable: Yes

Available on: Site engines only

Parameters:
None.

Answer data:
Success: none.
Error: the error code.

Description:

Clears the data set on the dynamic memory area.

Example:
#1*DYNMEMCLEAR
01|>
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4.4.5 DYNMEMSET

Command syntax:
DYNMEMSET <start addr> <len> <data> ... <data>

Scriptable: Yes 

Available on: Site engines only

Parameters:
start addr: address of the dynamic memory to start writing 

data to.
len: bytes number to write.
data: bytes to write.

Answer data:
Success: none.
Error: the error code.

Description:

Writes len bytes to the dynamic memory starting at address addr.
Dynamic memory is a special memory area (embedded in the 
FlashRunner electronics) which is typically used for storing temporary, 
variable data (e.g. serial numbers) before programming it to the target 
device. Dynamic memory retains its contents only as long as 
FlashRunner is powered. Both exadecimal and decimal digits are 
accepted

Example:
#1*DYNMEMSET 0x0000 4 0x00 0x01 0x02 0x03
01|>

#1*DYNMEMSET 125 4 12 21 1 4
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4.4.6 DYNMEMSET2

Command syntax:
DYNMEMSET2 <start addr> <len> <data stream>

Scriptable: Yes 

Available on: Site engines only

Parameters:
start addr: address of the dynamic memory to start writing 

data to.
len: number of bytes to write.
data stream: bytes stream to write defined by hexadecimal 

digits.

Answer data:
Success: none.
Error: the error code.

Description:

Writes len bytes to the dynamic memory starting at address addr.
Dynamic memory is a special memory area (embedded in the 
FlashRunner electronics) which is typically used for storing temporary, 
variable data (e.g. serial numbers) before programming it to the target 
device. Dynamic memory retains its contents only as long as 
FlashRunner is powered. 

Example:
#1*DYNMEMSET2 0x0000 4 AB123402FF
01|>
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4.4.7 FSEXIST

Command syntax:
FSEXIST <type> <filename>

Scriptable: No 

Available on: Master engines only

Parameters:
type: filetype you want to transfer: could be PRJ|LIB|

FRB|LIC|LOG.
filename: file to retrieve.

Answer data:
Success: none.
Error: the error code.

Description:

Check if a file of a specifi file type does exist in FlashRunner storage 
memory or not.

Example:
#55*FSEXIST PRJ test.prj
55|>

59



2

FlashRunner 2.0 Workbench

4.4.8 FSGETCONTROL

Command syntax:
FSGETCONTROL

Scriptable: No 

Available on: Master engine only

Parameters:
None.

Answer data:
Success: none.
Error: the error code.

Description:

Retrieves the read value from the lines belonging to control connector

Example:
#55*FSGETCONTROL 
55|Start line read value is: 1 
55|Control lines read value is: 31 
55|>
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4.4.9 FSGETFILE

Command syntax:
FSGETFILE <type> <filename>

Scriptable: No 

Available on: Master engine only

Parameters:
type: filetype you want to transfer: could be PRJ|LIB|

FRB|LIC|LOG.
filename: file to retrieve.

Answer data:
Success: none.
Error: the error code.

Description:

Copies a file stored in FlashRunner to the host system.
This command works only through the FlashRunner WorkBench 
software and copies files inside the related folder. To review your 
destination folders please click on “Tool” menu and click on “Settings” 
item. 

Example:
#55*FSGETFILE PRJ test.prj
55|>

61



2

FlashRunner 2.0 Workbench

4.4.10 FSLS

Command syntax:
FSLS

Scriptable: No 

Available on: Master engine only

Parameters:
type: directory you want to list: could be PRJ|LIB|FRB|

LIC|LOG.

Answer data:
Success: the current directory contents.
Error: the error code.

Description:

Lists the contents of the current directory in the FlashRunner.

Example:
#55*FSLS
55|ATXMEGA128A4.prj                         - 1019 
55|teridian.prj                             - 770 
55|atxmega.prj                              - 1036 
55|test.prj                                 - 1067 
55|>
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4.4.11 FSPUTFILE

Command syntax:
FSPUTFILE <type> <filename>

Scriptable: No 

Available on: Master engine only

Parameters:
type: filetype you want to transfer: could be PRJ|LIB|

FRB|LIC|LOG.
filename: file to send.

Answer data:
Success: none.
Error: the error code.

Description:

Copies a file stored in the host system to FlashRunner.
This command works only through the FlashRunner WorkBench 
software and copies files inside the related folder. To review your 
destination folders please click on “Tool” menu and click on “Settings” 
item. 

Example:
#55*FSPUTFILE PRJ test.prj
55|>
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4.4.12 FSRM

Command syntax:
FSRM <type> <filename>

Scriptable: No 

Available on: Master engine only

Parameters:
type: filetype you want to transfer: could be PRJ|LIB|

FRB|LIC|LOG.
filename: file to remove.

Answer data:
Success: none.
Error: the error code.

Description:

Removes a file stored in the host system to FlashRunner.

Example:
#55*FSRM PRJ test.prj
55|>
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4.4.13 FSSETCONTROL

Command syntax:
FSSETCONTROL <signal name> <signal value>

Scriptable: No 

Available on: Master engine only

Parameters:
signal name: could be BUSY|CH1|CH2...|CH16.
signal value: could be OFF|ON for BUSY signal or OFF|PASS|

FAIL for CH1...|CH16 channels.

Answer data:
Success: none.
Error: the error code.

Description:

Sets a signal belonging to control connector to a defined value.
PASS is low logic level, FAIL is high logic level. 

Example:
#55*FSSETCONTROL CH1 PASS
55|>
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4.4.14 GETDATE

Command syntax:
GETDATE

Scriptable: No 

Available on: Master engine only

Parameters:
None.

Answer data:
Success: current date.
Error: the error code.

Description:

Returns the current date set on FlashRunner. 
Date format is <sec> <min> <hour> <date> <month> <year>. 
<hour> is in 24 hour time format settings.

Example:
#55*GETDATE
55|current date: 8 4 15, 18.39.22
55|>
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4.4.15 GETENGSTATUS

Command syntax:
GETENGSTATUS

Scriptable: No 

Available on: Master engine only

Parameters:
None.

Answer data:
Success: current date.
Error: the error code.

Description:

Returns the actual engines status. The answer is composed by 16 
characters, one for each channel starting from left, and value could be 
“P”, “B”, “F” or “-”. “P” character stays for PASS status and means that 
last programming on this channel passed succesfully. “B” character 
stays for BUSY status and means that channel is still executing 
commands. “F” character stays for FAIL status and means that last 
programming on this channel failed, “-” character means that on this 
product, this channel is not enabled. 

Example:
#55*GETENGSTATUS
55|P_______--------
55|> 
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4.4.16 GETVPROG

Command syntax:
GETVPROG

Scriptable: No 

Available on: Site engines only

Parameters:
vprog line: vprog line to read for the selected channel. Could 

be 0|1.

Answer data:
Success: current voltage read value.
Error: the error code.

Description:

Returns the read value for the selected VPROG line in mV.

Example:
#1*GETVPROG 0
01|VPROG0=50
01|>
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4.4.17 ISPANELMODE

Command syntax:
ISPANELMODE

Scriptable: No 

Available on: Master engine only

Parameters:
None.

Answer data:
Success: if panel mode is enabled.
Error: the error code.

Description:

Returns if panel mode is enabled.

Example:
#55*ISPANELMODE

55|PANEL MODE OFF

55|>
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4.4.18 LISTLIC

Command syntax:
LISTLIC

Scriptable: No 

Available on: Master engines only

Parameters:

Answer data:
Success: license list.
Error: the error code.

Description:

Returns the stored license list.

Example:
#55*LISTLIC
55|MPC5644A.lic - 457
55|MPC5642A.lic - 457
55|SPC5606S.lic - 457
55|> [0:00.013]
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4.4.19 LOADDRIVER

Command syntax:
LOADDRIVER <driver name> <silicon name> <family 
name> <device name>

Scriptable: Yes 

Available on: Site engines only

Parameters:
driver name: driver filename which supports selected device.
silicon name: silicon producer name which supports selected 

device.
family name: family name which supports selected device.
device name: vprog line to read for the selected channel.

Answer data:
Success: none.
Error: the error code.

Description:

Returns the read value for the selected VPROG line in mV.

Example:
#1*GETVPROG 0
01|VPROG0=50
01|>
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4.4.20 LOGIN

Command syntax:
LOGIN <user> <password>

Scriptable: No 

Available on: Master engine only

Parameters:
user: username, you can choose between ADMIN|USER
password: USER has dummy password (any value accepted), 

ADMIN has dummy password until changed with 
SETADMINPW command

Answer data:
Success: none
Error: the error code

Description:

Login a user,  which has different command set enabled. 

Example:
#55*LOGIN ADMIN applepie
55|>
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4.4.21 LOGOUT

Command syntax:
LOGOUT

Scriptable: No 

Available on: Master engine only

Parameters:

Answer data:
Success: none
Error: none

Description:

It exit from ADMIN account and get back to USER account

Example:

#55*LOGOUT

55|>
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4.4.22 RLYCLOSE

Command syntax:
RLYCLOSE

Scriptable: Yes 

Available on: Site engines only

Parameters:
None.

Answer data:
Success: none.
Error: the error code.

Description:

Drives related channel signal on the Relay control connector in order 
to close the circuit. Putting this command inside a project will drives 
signals related to channel subset defined by ENGINEMASK pseudo-
command.

Example:
#1*RLYCLOSE
01|>
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4.4.23 RLYOPEN

Command syntax:
RLYOPEN

Scriptable: Yes 

Available on: Site engines only

Parameters:
None.

Answer data:
Success: none.
Error: the error code.

Description:

Drives related channel signal on the Relay control connector in order 
to open the circuit. Putting this command inside a project will drives 
signals related to channel subset defined by ENGINEMASK pseudo-
command.

Example:
#1*RLYOPEN
01|>

75



2

FlashRunner 2.0 Workbench

4.4.24 RUN

Command syntax:
RUN <project name>

Scriptable: Yes 

Available on: Site engines only

Parameters:
project name: project filename to run.

Answer data:
Success: none.
Error: the error code.

Description:

Starts a project stored inside FlashRunner 2.0 and defined by its 
filename.

Example:
#1*RUN test.prj
01|>
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4.4.25 RSTENGSTATUS

Command syntax:
RSTENGSTATUS

Scriptable: No 

Available on: Master engines only

Parameters:

Answer data:
Success: none.
Error: none.

Description:

Reset engined status internal value.

Example:
#55*RSTENGSTATUS
55|>
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4.4.26 SETADMINPW

Command syntax:
SETADMINPW <password>

Scriptable: No

Available on: Master engines only

Parameters:
password: new password for ADMIN user

Answer data:
Success: none.
Error: none.

Description:

Set up new password value for ADMIN user. This command is 
available only if you login ADMIN account.

Example:
#55*SETADMINPW newpassword
55|>
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4.4.27 SETDATE

Command syntax:
SETDATE <sec> <min> <hour> <date> <month> <year>

Scriptable: No 

Available on: Master engine only

Parameters:
sec: set seconds.
min: set minutes.
hour: set hours in 24 hour time format.
date: set date.
month: set month.
year: set year (last two digits).

Answer data:
Success: none.
Error: the error code.

Description:

Sets the current date on FlashRunner. 
Date format is <sec> <min> <hour> <date> <month> <year>. 
<hour> is in 24 hour time format settings.

Example:
#55*SETDATA 51 46 21 30 11 15
55|>
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4.4.28 SETIP

Command syntax:
SETIP <IP> <netmask> <gateway>

Scriptable: No 

Available on: Master engine only

Parameters:
IP: new programmer IP address.
netmask: new programmer netmask.
gateway: new programmer gateway.

Answer data:
Success: none.
Error: the error code.

Description:

Sets the new network settings for LAN peripheral. Once executed, you 
must reboot FlashRunner in order to enable new settings.

Example:
#55*SETIP 192.168.1.128 255.255.255.0 192.168.1.1
55|>
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4.4.29 SETLOGLEVEL

Command syntax:
SETLOGLEVEL <level>

Scriptable: Yes

Available on: Master and site engines

Parameters:
level: log verbosity level. It's a number within [1-5] range

Answer data:
Success: none.
Error: the error code.

Description:

Sets the log verbosity level. Lower numbers mean more verbosity on 
log file.

Example:
#55*SETLOGLEVEL 1
55|>
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4.4.30 SETMUX

Command syntax:
SETMUX <level>

Scriptable: No

Available on: Master engine only

Parameters:
level: 0 to isolate all outputs, 1 to enable first bank, 2 to 

enable second bank.

Answer data:
Success: none.
Error: the error code.

Description:

Sets demultiplexer. “0” value will isolate all outputs, “1” will enable the 
first bank and “2” value will isolate the second bank.

Example:
#55*SETMUX 1
55|>
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4.4.31 SETPANELMODE

Command syntax:
SETPANELMODE <level>

Scriptable: No

Available on: Master engine only

Parameters:
level: 0 to disable, 1 to enable panel mode

Answer data:
Success: none.
Error: the error code.

Description:

Enable panel mode. If programmer works in panel mode you could 
only load a single communication protocol for all channels. This 
usually drives to a performance improvement, although it will be target 
device-dependent.  

Example:
#55*SETPANELMODE 1
55|>
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4.4.32 SGETENG

Command syntax:
SGETENG

Scriptable: No

Available on: Site engines only

Parameters:
None.

Answer data:
Success: none.
Error: the error code.

Description:

Returns the engine instance number for the requested engine.

Example:
#1*SGETENG
01|Engine N. 0>
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4.4.33 SGETERR

Command syntax:
SGETERR

Scriptable: No

Available on: Master and site engines

Parameters:
None.

Answer data:
Success: the error code stack.
Error: none.

Description:

Returns the error stack related to the last error occurred on the 
selected engine. 
Each line follows the rule: 
ERR--><err num>|<desc>|[<src file>, <line num>,<func>]

Example:
#1*SGETERR
01|ERR-->05000007|(null)|[file ../Src/pi-
algo_api_rw.c, line 165, funct API_FrbSet()]
01|ERR-->05000007|(null)|[file ../Src/pi-algo.c, 
line 350, funct cmd_TPSETSRC()]
01|ERR-->05000007|(null)|[file ../Src/cli-cmd.c, 
line 305, funct cmd_RUN()]
01|> [0:00.003]
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4.4.34 SGETSN

Command syntax:
SGETSN

Scriptable: No

Available on: Master engine only.

Parameters:
None.

Answer data:
Success: the product serial number.
Error: none.

Description:

Returns the product serial number.

Example:
#55*SGETSN 
55|1 
55|> 
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4.4.35 SGETVER

Command syntax:
SGETVER

Scriptable: No

Available on: Master engine only.

Parameters:
None.

Answer data:
Success: the Operating System version.
Error: none.

Description:

Returns the Operating System version.

Example:
#55*SGETVER 
55|1.08
55|> 
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4.4.36 SGETVERALGO

Command syntax:
SGETVERALGO

Scriptable: No

Available on: Site engine only.

Parameters:
None.

Answer data:
Success: algorithm version.
Error: none.

Description:

Returns the version of driver indicated as parameter. Usually answer 
is a 3 digit number: 2 less significant are minor release, the other one 
is the major release 

Example:
#1*SGETVERALGO libsermem.so
01|102
01|>
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4.4.37 SGETVERALGOLIST

Command syntax:
SGETVERALGOLIST

Scriptable: No

Available on: Master engine only.

Parameters:
None.

Answer data:
Success: algorithm version list
Error: none.

Description:

Returns algorithm version of all drivers stored inside programmer. 
Usually answer is a 3 digit number: 2 less significant are minor 
release, the other one is the major release 

Example:
#55*SGETVERALGOLIST
55|libsermem.so - 102
55|libinf_c.so - 103
55|libatxmega.so - 102
55|>
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4.4.38 SPING

Command syntax:
SPING

Scriptable: No

Available on: Master engine only.

Parameters:
None.

Answer data:
Success: PONG.
Error: the error code.

Description:

Pings the instrument. Used to verify whether FlashRunner is 
connected to the host system and running correctly.

Example:
#55*SPING
55|PONG>
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4.4.39 TCSETDEV
Command syntax:

TCSETDEV <par name> <par value>

Scriptable: Yes

Available on: Site engines only.

Parameters:
par name: parameter name.
par value: parameter value.

Answer data:
Success: none.
Error: the error code.

Description:

Sets device-specific and programming algorithm-specific device 
information. This command must be sent after the LOADDRIVER 
command and before a TPSTART / TPEND command block. Please 
note that CRC pseudo command is a CRC number based on 
TCSETDEV data and is used to prevent device info tampering. For 
this reason, you can't calculate the CRC but you only can copy it from 
a working projects done with FlashRunner WorkBench software.

Example:
#1*TCSETDEV VDDMIN 1600
01|>
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4.4.40 TCSETPAR

Command syntax:
TCSETPAR <par name> <par value>

Scriptable: Yes

Available on: Site engines only.

Parameters:
par name: parameter name.
par value: parameter value.

Answer data:
Success: none.
Error: the error code.

Description:

Sets device-specific and programming algorithm-specific device 
parameter. This command must be sent after the LOADDRIVER 
command and before a TPSTART / TPEND command block. 

Example:
#1*TCSETPAR PWDOWN 20
01|>
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4.4.41 TESTVPROG

Command syntax:
TESTVPROG

Scriptable: No

Available on: Site engines only.

Parameters:
vprog line: vprog line to read for the selected channel. Could 

be 0|1.
mV: mV to set in output on selected vprog line for the 

selected channel.
output: defines if selected vprog line is in output or only 

defined internally as high reference value. Could 
be ON|OFF.

Answer data:
Success: the product serial number.
Error: none.

Description:

Sets up a defined value on vprog lines.

Example:
#1*TESTVPROG 0 3300 ON
01|> 
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4.4.42 TPCMD

Command syntax:
TPCMD <command> [par1] [par2] ... [parn]

Scriptable: Yes

Available on: Site engines only.

Parameters:
command: programming command.
par: zero or more programming command parameters.

Answer data:
Success: programming command specific.
Error: the error code.

Description:

Performs a programming operation (i.e. mass erase, program, verify, 
etc.) This command must be sent within a TPSTART/TPEND 
command block. Programming commands and their relative 
parameters are device-specific.

Example:
#1*TPCMD PROGRAM F
01|> 
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4.4.43 TPEND

Command syntax:
TPEND

Scriptable: Yes

Available on: Site engine only.

Parameters:
Success: none.
Error: the error code.

Answer data:
Success: the product serial number.
Error: none.

Description:

Ends a programming block. This command must be preceded by a 
TPSTART command. TPCMD commands must be sent within a 
TPSTART/TPEND command block.
TPSTART / TPEND command block must be preceded by the 
TCSETPAR commands required for your specific target device. The 
TPEND command resets any previously set device-specific and 
programming algorithm-specific parameters.

Example:
#1*TPEND 
01|> 
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4.4.44 TPSETDUMP

Command syntax:
TPSETDUMP <filename>

Scriptable: Yes

Available on: Site engines only.

Parameters:
filename Name of the dump file 

Answer data:
Success: none
Error: the error code.

Description:

Setup the filename which will be created on FlashRunner storage 
memory once TPCMD DUMP command will be executed. As 
FlashRunner executes the same project on several channels, each 
channel will has its own dump file. For this reason, on filename 
indicated with this command FlashRunner will apply prefix “S<chN>_”, 
where chN is the channel number to which dump refers. Dump file are 
raw binary files

Example:
#1*TPSETDUMP dumpfile.bin
01|> 
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4.4.45 TPSETSRC

Command syntax:
TPSETSRC <filename>

Scriptable: Yes

Available on: Site engines only.

Parameters:
filename: name of the file in the binaries folder inside 

FlashRunner

Answer data:
Success: none.
Error: the error code.

Description:

Sets the source of data to be used in subsequent TPCMD commands.

Example:
#1*TPSETSRC test.frb 
01|> 
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4.4.46 TPSTART

Command syntax:
TPSTART

Scriptable: Yes

Available on: Site engines only.

Parameters:
None.

Answer data:
Success: none.
Error: the error code.

Description:

Starts a programming block. To end a programming block, send the 
TPEND command. TPCMD commands must be sent within a 
TPSTART/TPEND command block.
The TPSTART command performs some internal initializations and 
prepares FlashRunner to execute subsequent TPCMD commands.

Example:
#01*TPSTART
01|> 
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Projects are sequences of commands collected in a text file. 
This is an handy way to store all the target device information 
and user settings needed to FlashRunner 2.0. Projects are 
usually created with Project Wizard tool (see ch 3.8 for more 
information) and stored in user data path folder. Once created, 
a project could be edited with any text editor. Please check the 
example below:

;Project START
;DEVICE: ATXMEGA32E5
;ALGO:   ATXMEGA

!ENGINEMASK 255
#LOADDRIVER libatxmega.so ATMEL ATXMEGA ATXMEGA32E5
#TCSETDEV VDDMIN 1600
#TCSETDEV VDDMAX 3600
#TCSETDEV FOSCMIN 0
#TCSETDEV FOSCMAX 0
#TCSETDEV FPLLMIN 0
#TCSETDEV FPLLMAX 0
#TCSETDEV MCUID 10520
#TCSETDEV IDCODE 0
#TCSETDEV IDCODE_MSK 268435455
#TCSETDEV CORE ATXMEGA
#TCSETDEV MEMMAP 0 F 0 8388608 8425471 128 128 0 0 0 0 255 0
#TCSETDEV MEMMAP 1 E 0 9175040 9176063 32 32 0 0 0 0 255 0
#TCSETDEV MEMMAP 2 L 0 9371680 9371695 1 1 0 0 0 0 255 0
#TCSETDEV MEMMAP 3 C 0 9306624 9306639 1 1 0 0 0 0 255 0
#TCSETDEV MEMMAP 4 U 0 9307136 9307151 1 1 0 0 0 0 255 0
!CRC 998762799
#TCSETPAR CLKOUT 0
#TCSETPAR PROTCLK 15000000
#TCSETPAR PWDOWN 100



#TCSETPAR PWUP 100
#TCSETPAR RSTDOWN 100
#TCSETPAR RSTDRV OPENDRAIN
#TCSETPAR RSTUP 100
#TCSETPAR VPROG0 3300
#TCSETPAR CMODE PDI
#TPSETSRC vipcb6_test.frb

#DYNMEMSET 0x8E0400 7 0x00 0xFF 0xFF 0xFF 0xFF 0xFF 
0x00

#TPSTART 
#TPCMD CONNECT 
#TPCMD MASSERASE C
#TPCMD BLANKCHECK F
#TPCMD PROGRAM F
#TPCMD VERIFY F R
#TPCMD BLANKCHECK E
#TPCMD PROGRAM E
#TPCMD VERIFY E R
#TPCMD PROGRAM U
#TPCMD PROGRAM L
#TPCMD DISCONNECT
#TPEND

;Project END

Example above shows a simple project example 
which configure a channel subset for a target 
device. There could be more than one target 
device configured inside the same project,  
requiring another commands block (starting with 
!ENGINEMASK and finishing with #TPEND) which 
defines the new target device settings. Channel 
subset involved for a specifig target device is 
defined by !ENGINEMASK command: the following 



number will bitwise define channels involved: 
!ENGINEMASK 178, 17810 = 101100102. Each number in 
base 2 defines one channel, starting from less significative. 
Number value (1 or 0) defines if channel is selected or not: 
example above activates channels 2, 5, 6 and 8.
Following section will define target device (through 
#LOADDRIVER) and all the specific device information (through 
#TCSETDEV command). This section will be closed by !CRC 
command: this number will prevent from altering the information 
above which contain sensible data and would compromise the 
programming operation.
Next section is composed mainly by #TCSETPAR and 
#TPSETSRC commands, which defines set of user 
defined parameters (result of Project Wizard 
settings). These commands are editable and 
order doesn't matter. 
Last section is enclosed between #TPSTART and 
#TPEND commands and defines which operation 
will be executed on target device. These 
commands are editable, the order does matter 
and we suggest not to change it once Project 
Wizard will compile this file.
Commands related to single memory types have 
double syntax:

#TPCMD PROGRAM F

Will program automatically memory type areas defined by 
loaded FRB file.

#TPCMD PROGRAM F 0x0 0x100

Will program memory type areas defined by command 
parameters above. Target start address is 0x0, lenght 0x100. If 



loaded FRB doesn't contain any data in this area target device 
will not by programmed.

Usually double syntax is available for PROGRAM, VERIFY, 
BLANKCHECK commands.

5.1 Execution and Termination

5.1.1 Standalone project execution

FlashRunner 2.0 has a control connector, a group of control 
lines (SEL[4..0] in the “CONTROL” Connector, for hardware 
details please refer to FlashRunner 2.0 User's Manual) 
determines in binary logic a decimal number from 0 to 32 which 
will execute project named project0.prj....project31.prj. 
The event that triggers script execution is the START control 
line becoming active (while the BUSY line is not active). This 
line can be easily driven by the ATE control logic.
When FlashRunner 2.0 begins executing a project, “BUSY” 
LED turns on. 
The following diagram illustrates typical temporal relations 
between the various FlashRunner 2.0 control lines. 



 

START 

SEL lines are latched 

Corresponding script is executed 

Result LEDs are turned off Either “PASS” or “FAIL” LED is turned on 

SEL[4..0] 

BUSY 

PASS/FAIL 

Script execution 
terminated 

Figure 22: Control connector time diagram

5.1.2 Remote projects execution

Additionally, projects can be manually executed in host mode.  
RUN command (see ch 4.4.24) executes a specified project.
5.1.3 Projects Termination

Projects execution ends either after FlashRunner 2.0 has 
executed last project command or immediately after the first 
failing project command.

5.2 Project-Specific Directives

FlashRunner 2.0 commands contained in a projects are 
executed sequentially, exactly as they would be executed in 
Host mode. However, projects contain additional directives (not 
available in Host mode) indicated with “!” prefix which control 
how projects are executed. The following table lists these 
directives.



Each directive is valid from its line forward.

5.3 Logging

On FlashRunner 2.0, project command execution is logged. 
You can check at runtime log file (see ch 3.12) or download log 
file by opening Advanced File Manager (see ch 3.10), clicking 
on “Log” remote folder and clicking “Get” button in order to 
upload it to host machine.

08|2|001208-03:31:33|---#TPCMD CONNECT 
08|1|001208-03:31:33|PROT_CLK: Req=12500000 Actual=12500000
08|2|001208-03:31:33|>|

5.4 Comments

A project line may contain a comment. As commands are 
preceeded by “#” command, anything else is ignored by 
FlashRunner 2.0 and so can be used as comment.

Directive Syntax Description

ENGINEMASK Defines bitwise which channels are involved for the 
following command section

CRC Calculate CRC of the preceeding commands in order to 
avoid specific target device data altering.



5.5 Conditional scripting

With the aim of raising the flexibility and the customization of 
projects, FlashRunner 2.0 implements low level commands able 
to control the flow of the script’s commands. 
Syntax used gets back to classical programming languages and 
shall be immediately clear to all the users familiars with them, 
because it reproduces if, then, else statement.
In fact, in “C” programming language control flow syntax is as 
follows:

if (expression) 
statement1 

else 
statement2 

where the else part is optional. Expression is evaluated; if it is 
true (that is, if expression has a non-zero value), statement1 is 
executed. If it is false (expression is zero) and if there is an else 
part, statement2 is executed instead.2

In FlashRunner 2.0 the same goal can be achieved using the 
syntax below inside any project file:

#IFERR expression
#THEN statement1

in which expression  is TRUE when the command returns “>“ 
character (meaning that command has been executed 

2

 “The ANSI C Programming Language” 2nd ed., Brian W. Kernighan and Dennis M. 
Ritchie, Prentice Hall



successfully), or it is FALSE if the command returns an error 
(with correspondant error code). 

Notes:
 Please note that syntax above can be used only inside a 

script file and it’s not recognized on command line
 Control flows can’t be nested
 Only one expression can be evaluated and only one 

statement can be executed for each case
 If expression evaluation return false, error stack will be 

traced in the log file. Anyway, if all the subsequent 
commands will return “>”, project will not return with a 
execution error.

The following example is an extract from a script where the 
MASSERASE operation is carried out only if blank check 
operation returns an error, that is the device to be programmed 
is not blank. 

#IFERR TPCMD BLANKCHECK F
#THEN TPCMD MASSERASE C

With this approach it is often possible to reduce project 
execution time. This tecnique applies mostly on conditioning 
target device memory erasing only if blancheck fails.
Please refer to your driver specific commands before 
implementing conditional scripting it in your projects.



6 Serial Numbering

6.1 Introduction

Thanks to its built-in dynamic memory, FlashRunner 2.0 
provides you with the possibility of serial numbering during 
programming operations. During each programming cycle, an 
host system generates a serial number and transfers it to 
FlashRunner 2.0’s dynamic memory. The content of the 
dynamic memory is then programmed into the target device.

6.2 Command syntax

The following example illustrates how serial numbering can be 
performed.
Let’s assume that the serial number is composed by 4 bytes, 
must be programmed into target device connected to channel 1, 
flash starting from address 0x400, and that serial number to be 
programmed is 0x55 0xAA 0x22 0xFE.
Host system transfers this serial number to FlashRunner’s 
dynamic memory with the following command :

#1*DYNMEMSET 0x400 4 $55 $AA $22 $FE

or with the following command:

#1*DYNMEMSET2 0x400 4 55AA22FE



And FlashRunner 2.0 will apply this “patch” over FRB data. You 
can define more than one patch, virtually without limits (physical 
limit is FlashRunner 2.0 1 GB RAM), but defined data is 16 
bytes for DYNMEMSET, and a total of 512 bytes for the entire 
DYNMEMSET2 command. Contiguous defined area will be treated 
as one.

6.3 Example

...
#TCSETPAR RSTUP 100
#TCSETPAR VPROG0 3300
#TCSETPAR CMODE JTAG
#TPSETSRC APH_U27_varD.frb
#DYNMEMSET 0xA0604020 4 0x39 0x30 0x41 0x46
#DYNMEMSET 0xA06040A0 3 0x44 0x48 0x31
#TPSTART 
#TPCMD CONNECT 
#TPCMD MASSERASE D
#TPCMD BLANKCHECK D
#TPCMD PROGRAM D
#TPCMD VERIFY D R
#TPCMD MASSERASE F
#TPCMD BLANKCHECK F
#TPCMD PROGRAM F
#TPCMD VERIFY F R
#TPCMD DISCONNECT
#TPEND

APH_U27_varD.frb must contains defined region at start 
address 0xA0604020 for 10 bytes size and 0xA06040A0 for 8 
bytes size. If your source file doesn't cover this region please 
use FRB Manager (see ch 3.14) in order to define it (use 
Advanced FRB setup feature → Add → Variable data option).



Once defined, this data will be programmed overwriting FRB 
original data, together with PROGRAM command in a single 
step.



7 Data Protection System

7.1 User management

User management lets users to switch between two modes: 
Administrator and User modes. Administrator is enabled to 
execute all commands, User instead has access to a subset of 
all commands. 
By default, FlashRunner 2.0 starts in Administration mode, if 
you want to change accountit you must use #LOGIN command 
(see ch 4.4.20). 
While User account doesn't have a password (so any value as 
password parameter for #LOGIN command is accepted), 
Administor could have a password. By default, also 
Administrator account accept any value as #LOGIN password 
parameter, unless you decide to set it. If you want to set 
Administrator password please use #SETADMINPWD (See ch 
4.4.26) with the following procedure:
 Send #LOGIN ADMIN dummy
 Send #SETADMINPWD new_password
From this moment on, if you want to login as Administrator you 
must enter new_password. Once user sets a password for 
Administration mode, FlashRunner 2.0 will start in user mode.

 

i 
Note: untill #DYNMEMCLEAR command, dynamic data  
will be mantained during project execution loop



Table below lists the FlashRunner commands available for 
each user. 

7.2 FRB encryption

Each FRB could be encrypted using the FlashRunner 2.0 
Workbench tool (See ch 7.2). 
This feature will produce a new file, with .frs extension, which is 
the encrypted version of the original file. New .frs file can't be 
encrypted anymore.
In order to use it please upload .frs to FlashRunner 2.0 (using 
Advanced File Manager, see ch 3.10) and change #TPSETSRC 
filename extension on related project, finally upload project to 
FlashRunner 2.0.

Command
Unsecured
Mode

Secured Mode
(Administrator)

SETADMINPWD - 

CLRLOG - 



8 FlashRunner 2.0 Interface 
Library

8.1 Overview

This chapter deals with interfacing user written PC applications 
with FlashRunner 2.0. This chapter assumes you have already 
read the previous sections of this manual and got acquainted 
with the instrument.

8.2 FlashRunner 2.0 Interface Library

FlashRunner 2.0 Interface Library is a DLL which includes all of 
the functions that allow you set up a communication channel 
with the instrument and send commands to FlashRunner 2.0.
Dynamic-link libraries (DLL) are modules that contain functions 
and data. A DLL is loaded at run time by its calling modules 
(.exe or .dll). When a DLL is loaded, it is mapped into the 
address space of the calling process.
FlashRunner 2.0 Interface Library contains Visual C++ written 
routines, and can be used to interface the instrument from 
within, for example, a Microsoft Visual C++ or Visual Basic 
application, as well as any other programming language that 
supports the DLL mechanism. For details on how to call DLL 
functions from within your application, please refer to the your 
programming language’s documentation.



8.3 Installation

Before to start working with the FlashRunner Interface Library, 
you must set up your system with all the required files and 
drivers. The files to be installed, into your application’s 
directory, are:

 The “FR_COMM.dll” (this file must also be redistributed 
with your application);

 For Visual C++ only: the “FR_COMM.lib” and 
“FR_COMM.h” files (you must include these files in your 
project);

 For Visual Basic only: the “FR_COMM.bas” file (you must 
include this file in your project).

These files are automatically installed by the System Software 
setup (in your  installation path).

8.4 Interface Library Reference

8.4.1 Using the Interface Library Functions

When you control FlashRunner 2.0 within your own application, 
you will typically follow the steps indicated below:

• Open a communication channel with the instrument.
The FR_OpenCommunication() function must be called prior 
to any other Interface Library function.

• Send commands to the instrument and read answers 
back.
Use the FR_SendCommand() and FR_GetAnswer() functions 



to send a command and receive the answer sent back by 
the instrument, respectively.

• Transfer files to/from FlashRunner 2.0.
Two dedicated functions, FR_SendFile() and 
FR_GetFile(), allow you to transfer a file from the PC to 
FlashRunner 2.0 and vice-versa, respectively.
The FR_SendFile() function is typically used to upload a 
binary file to the instrument, while the FR_GetFile() 
function is typically used to download a log file to the PC.

• Close the communication channel with the instrument.
This is done by the FR_CloseCommunication() function.

8.4.2 Return Values of the Interface Library Functions

Most of the FlashRunner 2.0 Interface Library functions return 
an unsigned long value which indicates whether the function 
was successfully executed (return value = 0) or not (return 
value other than 0). In the latter case it is possible to get 
extended error information by calling the function 
FR_GetLastErrorMessage() function.

8.4.3 Unicode Functions

Every Interface Library function comes in two versions, an 
ASCII version and an Unicode version. ASCII function names 
end with A, while Unicode function names end with W. For 
example, the FR_SendCommand() function is available as an 
ASCII version as:

FR_COMM_ERR WINAPI FR_SendCommandA (FR_COMM_HANDLE 
handle, const char *command); 

and as an Unicode version as:



FR_COMM_ERR WINAPI FR_SendCommandW (FR_COMM_HANDLE 
handle, const wchar_t *command);

8.4.4 Application examples 
Application examples for Visual C and Visual Basic are 

provided in the local installation path.



8.4.5 Function Reference for FR 2.0

8.4.6 FR_CloseCommunication

Include file:
#include “FR_COMM.h”

Function prototypes:
FR_COMM_ERR WINAPI FR_CloseCommunicationA

(FR_COMM_HANDLE handle);
FR_COMM_ERR WINAPI FR_CloseCommunicationW

(FR_COMM_HANDLE handle);

Parameters:
handle: handle of the communication. This is the value 

returned by the FR_OpenCommunication() 
function.

Return value:
0: the function was successful.
Other than 0: an error occurred. Call the 

FR_GetLastErrorMessage() function to get 
extended error information.

Description:

Closes the communication link with the instrument.



8.4.7 FR_GetAnswer

Include file:
#include “FR_COMM.h”

Function prototypes:
FR_COMM_ERR WINAPI FR_GetAnswerA

(FR_COMM_HANDLE handle,
char *answer,
unsigned long maxlen,
unsigned long timeout_ms);

FR_COMM_ERR WINAPI FR_GetAnswerW
(FR_COMM_HANDLE handle,
wchar_t *answer,
unsigned long maxlen,
unsigned long timeout_ms);

Parameters:
handle: handle of the communication. This is the value 

returned by the FR_OpenCommunication() 
function.

answer: buffer that will receive the answer 
(\0 terminated) of the instrument.

maxlen: maximum number of characters to 
receive (must be less than or equal 
to the answer buffer length).

timeout_ms: timeout, in milliseconds, after which 
the function returns even if a 
complete answer has not been 
received.

Return value:
0: the function was successful.



Other than 0: an error occurred. Call the 
FR_GetLastErrorMessage() function to get 
extended error information.

Description:

Receives the answer sent by FlashRunner 2.0 to the PC, in response 
to the FR_SendCommand() function. A FR_GetAnswer() 
function should always follow a FR_SendCommand() 
function.



8.4.8 FR_GetFile

Include file:
#include “FR_COMM.h”

Function prototypes:
FR_COMM_ERR WINAPI FR_GetFileA

(FR_COMM_HANDLE handle,
const char *protocol,
const char *src_filename,
const char *dst_path, 
const char *filetype,
FR_FileTransferProgressProc 
progress);

FR_COMM_ERR WINAPI FR_GetFileW
(FR_COMM_HANDLE handle,
const wchar_t *protocol,
const wchar_t *src_filename,
const wchar_t *dst_path,
const wchar_t *filetype,
FR_FileTransferProgressProc 
progress);

Parameters:
handle: handle of the communication. This is the value 

returned by the FR_OpenCommunication() 
function.

protocol: transfer protocol. Must be “YMODEM”.
src_filename: name of the file to be retrieved from 

FlashRunner 2.0, e.g. "test.prj.
dst_path: local path where to save the file.
filetype: could be FRB|PRJ|LIC|LOG|LIB.
progress: address of a callback function which 

will receive the progress status of 
the file transfer operation. If not 
used, set this parameter to NULL.



Return value:
0: the function was successful.
Other than 0: an error occurred. Call the 

FR_GetLastErrorMessage()function to get 
extended error information.

Description:

Retrieves a file from FlashRunner 2.0 and stores it in a specified local 
path.



8.4.9 FR_GetLastErrorMessage

Include file:
#include “FR_COMM.h”

Function prototypes:
void WINAPI FR_GetLastErrorMessageA

(char *error_msg,
unsigned long string_len);

void WINAPI FR_GetLastErrorMessageW
(wchar_t *error_msg,
unsigned long string_len);

Parameters:
error_msg: buffer that will receive the error 

message.
string_len: length of the buffer.

Return value:
none.

Description:

Most of the FlashRunner 2.0 Interface Library functions return an 
unsigned long value which indicates whether the function was 
successfully executed (return value = 0) or not (return value other 
than 0). In the latter case it is possible to get extended error 
information by calling the function FR_GetLastErrorMessage() 
function.



8.4.10 FR_OpenCommunication

Include file:
#include “FR_COMM.h”

Function prototypes:
FR_COMM_HANDLE WINAPI FR_OpenCommunicationA

(const char *port,
const char *settings);

FR_COMM_HANDLE WINAPI FR_OpenCommunicationW
(const wchar_t *port,
const wchar_t *settings);

Parameters:
port: communication port. Must be “LAN” for Ethernet 

communication “USB”for USB 
communication.

settings: IP address and port for Ethernet communication 
(e.g. “192.168.1.100:1234”), Serial Port for 
USB (e.g. “COM5”).

Return value:
>0: handle of the communication.
NULL: an error occurred. Call the 

FR_GetLastErrorMessage() function to get 
extended error information.

Description:

Creates a communication link with the instrument. Returns a 
communication handle that must be used by successive FlashRunner 
2.0 Interface Library function calls.



8.4.11 FR_SendCommand

Include file:
#include “FR_COMM.h”

Function prototypes:
FR_COMM_ERR WINAPI FR_SendCommandA

(FR_COMM_HANDLE handle,
const char *command);

FR_COMM_ERR WINAPI FR_SendCommandW
(FR_COMM_HANDLE handle,
const wchar_t *command);

Parameters:
handle: handle of the communication. This is the value 

returned by the FR_OpenCommunication() 
function.

command: string containing the FlashRunner 
command.

Return value:
0: the function was successful.
Other than 0: an error occurred. Call the 

FR_GetLastErrorMessage() function to get 
extended error information.

Description:

Sends a command to FlashRunner. To get the command answer, use 
the FR_GetAnswer() function.



8.4.12 FR_SendFile

Include file:
#include “FR_COMM.h”

Function prototypes:
FR_COMM_ERR WINAPI FR_SendFileA

(FR_COMM_HANDLE handle,
const char *protocol,
const char *src_filename,
const char *dst_path,
FR_FileTransferProgressProc 
progress);

FR_COMM_ERR WINAPI FR_SendFileW
(FR_COMM_HANDLE handle,
const wchar_t *protocol,
const wchar_t *src_filename,
const wchar_t *dst_path,
FR_FileTransferProgressProc 
progress);

Parameters:
handle: handle of the communication. This is the value 

returned by the FR_OpenCommunication() 
function.

protocol: transfer protocol. Must be “YMODEM”.
src_filename: name of the file (inclusive of the 

path) to be sent to FlashRunner, e.g. 
"C:\\MYBINARIES\\FLASH1.FRB".

dst_path: could be FRB|PRJ|LIC|LOG|LIB.
progress: address of a callback function which 

will receive the progress status of 
the file transfer operation. If not 
used, set this parameter to NULL.

Return value:
0: the function was successful. 



Other than 0: an error occurred. Call the 
FR_GetLastErrorMessage() function to get 
extended error information.

Description:

Sends a file from the PC to a specified path of FlashRunner 2.0.



9 Troubleshooting

This section collects a set of troubleshooting tecniques in order 
to program succesfully your device with FlashRunner 2.0. 
FlashRunner 2.0

9.1 Project execution failures

If you are executing a project and FlashRunner 2.0 answers to 
project execution with FAIL please open Real Time Log tool, 
described on chapter 3.12. Click on Log tab, click on Clear 
button, Run again project and check related error description. 
Usuallty a failure on “Connect” command execution means that 
FlashRunner 2.0 and target device are not correctly 
communicating.

 Please check that project is set for the exact device 
mounted on your board

 Please check cable wirings using PinMap tool described on 
chapter 3.13.

 Verify you are running the correct channel
 Verify that all connections have been wired correctly using a 

tester: 
1. check which test point/connector pin implements 

function described on PinMap tool and verify 
continuity test point/connector pin and FlashRunner 
2.0 ISP connector pin. In order to to this you may find 



usefull target board schematic and target board test 
point map.

2. Did you confused RX signal with TX signal? Is the 
soldering rugged?

3. Check which device pin is connected to each test 
point/connector pin. Check continuity between device 
pin and FlashRunner 2.0 ISP connector.

4. Does each signal they have passive components in 
between that could cause interference? If 
capacitance or resistor are needed on some lines 
(check it on device datasheet) verify that they have 
beed designed on your board under specification

 Is board powered up correctly? If you are using 
FlashRunner VPROG1, please try with an external power 
supplier. Do current absorption reaches a realistic value? 
(at least 30mA)

 If you are using external power supply, be sure that 
FlashRunner 2.0 GND line is coupled with external supplier 
GND line.

 If you are using FlashRunner 2.0 VPROG0 line together 
with external supplier, be sure that VPROG0 reference is 
the same as the one defined by target board design 
reference.

 If you are using FlashRunner 2.0 VPROG1 line, you must 
be sure that board current absorption is less that 
FlashRunner model maximum current level supported. 
Please check FlashRunner 2.0 User's Manual in order to 
get maximum current absorption on VPROG0 and VPROG1

 Has this board been already programmed? Firmwares 
could affect device startup, please try always with a device 
in erased state.



 Is there a watchdog active on the board? If yes please 
check how to disable it.

 Try slowing down communication frequency to the lowest 
value accepted (100kHz usually is available)

 Try increasing PWUP, PWDOWN, RSTUP, RSTDOWN 
values

 GND reference must not float
 Please use an oscilloscope in order to check if signals are 

affected by “glitches”, if they are present try to compensate 
by putting a small capacitance between this signal and 
GND

 Signals must have a specific time frame for rising edge and 
falling edge. Check on datasheet which are these 
constraints and check if they are satisfied. If not put a power 
up resistor (resistor between GND and VPROG0) or a 
power down resistor.

 Remember that cable wirings must be shortest as possble. 
Try reducing their lenght, especially if they are more than 30 
cm long and always use twisted and shielded cables.

In case of assistance need please open Real Time Log tool, 
described on chapter 3.12. Click on Log tab, click on Clear 
button, Run again project, check related error description. 
Contact support@smh-tech.com attaching this error log in your 
email together with SGETVER command answer (please check 
chapter 3.11 and 4.4.35 for more information)

mailto:support@smh-tech.com
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